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Protecting Host from Net
Host / OS Hardening



OS Hardening: General Consideration

e Differs per operating system

— 0S X : make things work magically for users. Try to
handle security issues in the background

— Windows: users can not be trusted to make security
related decisions in almost all cases.

— Linux: varies by distribution:

 Ubuntu: try like 0S X to make things just work.

* RedHat: include very useful tools but turned off by
default

« Slackware: users are experts - they’ll figure it out.
* Changes with time



OS Hardening: General Consideration

« Define a personal usage profile and policy.

What hardware do you use?
What software tasks do you do on your computer?
Do the first two change when you travel?

What habits from the above two do you need to change
to be more secure?

Decide if you really need VPN access to your network
while travelling.



OS Hardening: General Consideration

* Install only the services and software you actually
need.

e Uninstall or disable all software and services you do
not use or need.

e Periodically actively scan your machine for
vulnerabilities.

e Have as few user accounts on your systems as possible

* Protect your administrative account. Have a strong
password, do not permit remote password based logins
and do not log in as an administrator unless you need
to do an administrative task.



Hardening: hardware and firmware

Rule 1: all bets are off with physical access to
your devices.

Consider removing (from laptops mostly) hardware
you never use - say bluetooth.

Disable in BIOS or EFI or your operating system
the hardware or features you can not remove
physically.

— wake-on-1lan

— Bluetooth discoverability

— USB ports?



Host Hardening
Windows



All Windows Lover

Moving to Windows 7?

| Start here |
@ WHAT? Moving to Windows

What does end of support mean to customers? 8.1?

Jumpstart your Windows XP



Host Hardening : Windows

* Which Windows operating system should I use
* What is a workgroup?

* What 1is Active Directory?

* What are local users and groups?

* What is Group Policy, and why is it so
important?



Securing Windows: Best Practices

e Disable Guest Account
— Start->Control Panel->UserAccounts

e Configure an update method to install patches
— Start->Control Panel->System > Automatic Updates tab

* Disable unused system services
— Start->Control Panel->Administrative Tools->Services



Securing Windows: Best Practices

* Verify the appropriate Local Security Settings
— Start->Control Panel->Administrative Tools->Local
Security Settings
* Check the Windows Firewall settings

— Start->Control Panel->Network Connections and choose
the network connection that corresponds to your
Internet connection



Securing Windows: Best Practices

e Install an antivirus application
— Lot of options. But watch out for fake one
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Securing Windows: Best Practices

* Disable hiding of file extensions

— Start->Control Panel->Appearance and
Personalization->Folder Options->View->Advance
Settings



Securing Windows: Best Practices

e Install more secure default applications:
— Firefox or Chrome rather than Internet Explorer

— Thunderbird or Claws instead of Outlook (unless you
need exchange access)

— A different MTA rather than Exchange for servers
(unless you really need the groupware features)

— Configure applications to at minimum warn when VBA
extensions or macros want to run



Securing Windows: Best Practices

* For more

— http://www.microsoft.com/security/default.aspx

B® Microsoft

Safety & Security Center

Home  Security  Privacy  Family Safety  Resources Newsletter |1 7Y

Get Help

Explore Microsoft
Support options

Remove viruses with

the Safety Scanner

n’p | want to...

A : | =t (S Help kids stay safer online
N d At \“\
|

Turn on family safety settings
Stand up to online bullying

Socializing more : \
safely

() Avoid scams and hoaxes

Help protect your online " / 0 0
reputation, mobile devices, and 4 > 4 @ Protect my information
social networks ™~

(%) Get password guidance



Host Hardening
Linux



Securing Linux

e Available features differ by distribution.

— Use as few different distributions in your
environment as possible.

e Some distributions have optional scripts to
“harden” your system e.g. SuSE, RedHat

e Using security distro like Kali Linux/
Backtrack doesn’t mean you are secure.



Securing Linux

* UNIX security model is based on permissions -
ensure they are sane:

— check for SUID/SGID applications

 Some distros will include a nightly check for such
applications.

— Many distros have permission profiles that range
from permissive to paranoid that essentially limit
or permit people from/to run(ning) particular
applications or accessing particular files like
logs.

* Run the periodic scripts that reset these permissions.



Securing Linux

* For servers, always pick the “minimal”
installation to ensure as few packages as
possible end up on the system by default.

e Use system tools to disable services that are
required by other packages but do not need to
be running. E.g some packages will not install
if you do not have an SMTP server.



Securing Linux

* Periodic security checks:

— Checksums of system files kept offline and checked
against the running system

 tripwire
 fcheck
— Periodic scans of the system.
* nmap
* Openvas
e Realtime checks

— incrond /inotify - kernel feature to notify you as soon
as a specified watchlist of inodes are changed.



Securing Linux: Best Practices

1. Minimize Software to Minimize Vulnerability

— CentOS/Fedora
# yum list installed
# yum list packageName
# yum remove packageName
— FreeBSD/Ubuntu
# dpkg --list
# dpkg --info packageName
# apt-get remove packageName



Securing Linux: Best Practices

2. Keep Linux Kernel and Software Up to Date

— CentOS/Fedora
# yum update

— FreeBSD/Ubuntu
# apt-get update && apt-get upgrade



Securing Linux: Best Practices

3. User Accounts and Strong Password Policy

— A good password includes at least 8 characters long
and mixture of alphabets, number, special character,

upper & lower alphabets etc. Most important pick a
password you can remember

— Verify No Accounts Have Empty Passwords?
# awk -F: '($2 == "") {print}' /etc/shadow
— Lock all empty password account

# passwd -1 accountName



Securing Linux: Best Practices

4. Disable root Login
— Never ever 1login as root user. You should use sudo
to execute root level commands as and when required.
# vi /etc/ssh/sshd config
-> PermitRootLogin no
# /etc/init.d/sshd restart



Securing Linux: Best Practices

5. Physical Server Security

— Configure the BIOS and disable the booting from
external devices such as DVDs / CDs / USB pen. Set

BIOS and grub boot loader password to protect these
settings.



Securing Linux: Best Practices

6. Disable Unwanted Services

— Disable all wunnecessary services and daemons
(services that runs in the background).
# chkconfig --list | grep '3:on’

— To disable service, enter:
# service serviceName stop

# chkconfig serviceName off



Securing Linux: Best Practices

7. Separate Disk Partitions

— Separation of the operating system files from user
files may result into a better and secure system.
Make sure the following filesystems are mounted on

separate partitions:
 /usr
* /home
e /var and /var/tmp
 /tmp



Securing Linux: Best Practices

8. Secure OpenSSH Server

— Change SSH Port
# /etc/ssh/sshd config
-> Port 420 #default port is 22



Securing Linux: Best Practices

9. TCP Wrappers
# vi /etc/hosts.allow
sshd:[2405:7600:0:6::250]1/128, 202.4.96.250
# vi /etc/hosts.deny
ALL:ALL



Securing Linux: Best Practices

10. Check Listening Network Ports
# netstat —tulpn

Active Internet connections (only servers)
Proto Recv-Q Send-Q Local

tcp
tcp
tcp
tecp
tcpb
udp
udp

0

O O ©O O o o

0

0
0
0
0
0
0

0.0.0.0:
127.0.0
0.0.0.0:
0.0.0.0
:::420
0.0.0.0:
0.0.0.0:

Address

27017

.1:3306

80

:28017

1812
1813

Foreign
0:

s *

0

o O O

o O
. .

.0.0.
.0.0.
.0.0.
.0.0.

.:*

.
o O
.

o O O
.

Address

*

:*

e %

State

LISTEN
LISTEN
LISTEN
LISTEN
LISTEN

PID/Program name
1073/mongod

1094 /mysqgld
1770/nginx

1073 /mongod
952/sshd
18720/radiusd
18721/radiusd



Securing Linux: Best Practices

11. SSH Banner

# vi /etc/issue.net

1 WARNING !
You have accessed a restricted device.
All access is being logged and any unauthorized access
will be prosecuted to the full extent of the law.
# vi /etc/ssh/sshd config

Banner /etc/issue.net



Securing Linux: Best Practices

12. Review Log

/var/log/message - Where whole system 1logs or current
activity logs are available

/var/log/auth.log - Authentication logs
/var/log/kern.log - Kernel logs

/var/log/cron.log - Crond logs (cron job)
/var/log/maillog - Mail server logs
/var/log/boot.log - System boot log
/var/log/mysqld.log - MySQL database server log file
/var/log/secure - Authentication log

/var/log/utmp or /var/log/wtmp : Login records file
/var/log/yum.log: Yum log files



Host Hardening
Mac OSX



Securing Mac 0SX: Best Practices

Allow apps installation from “Mac App Store and
identified developers”™

® O C Security & Privacy
| @« | » || ShowAll | Q

FileVault Firewall Privacy

A login password has been set for this user Change Password...

Require password | immediately 3 | after sleep or screen saver begins

Show a message when the screen is locked Set Lock Message

Allow apps downloaded from:

Mac App Store
Mac App Store and identified developers
(s) Anywhere

L
'] " Click the lock to prevent further changes. Advanced...




Securing Mac

Enable Firewall

OSX: Best Practices

® O C Security & Privacy
| «|» || ShowAll | Q

General FileVault Privacy

© Firewall: On Turn Off Firewall

The firewall is turned on and set up to prevent unauthorized applications, programs,
and services from accepting incoming connections.

Firewall Options...

Ul
'] l‘ Click the lock to prevent further changes. Advanced...




Securing Mac 0SX: Best Practices

Disable unused services

® O O Sharing

[« /> || ShowAll | Q

Computer Name: |

Computers on your local network can access your computer at: Edit
Fakruls-MacBook-Air.local -

On  Service ) Screen Sharing: Off

L Screen Sharing Screen Sharing allows users of other computers to remotely view and
File Sharing control this computer.

Printer Sharing
Remote Login
Remote Management

Computer Settings... |

Remote Apple Events Allow access for: | ;“AII users

Internet Sharing (#) Only these users:

Bluetooth Sharing 22 Administrators
+ | -




Securing Mac 0SX: Best Practices

Read and understand security guides at
http://www.apple.com/support/security/guides/
(not updated for Lion or Mountain Lion)

Mac OS X v10.6 (Snow Leopard)
= Mac OS X Security Configuration Guide

= Mac OS X Server Security Configuration Guide

Mac OS X v10.5 (Leopard)
= Mac OS X Security Configuration Guide

= Mac OS X Server Security Configuration Guide

Mac OS X v10.4 (Tiger)

= Mac OS X Security Configuration Guide

= Mac OS X Server Security Configuration Guide
Mac OS X v10.3 (Panther)

= (Client Security Configuration Guide

= Server Security Configuration Guide



Protecting Host from Net
Patch & Updates /Security Updates



Patch

“A patch is a small piece of software that is
used to correct a problem with a software
program or an operating system. Patches are
often called "fixes." Service packs usually
contain many different patches.”



Security Updates

Microsoft Security Updates
http://www.microsoft.com/security/default.aspx

Apple Security Updates
http://support.apple.com/kb/ht1222




Getting Security Updates

e Subscribe to application/host specific
security updates.

e RSS Feed!!!
e Twitter Feedback!!!]

e Subscribe US-CERT Cyber Awareness System.
— http://www.us-cert.gov/ncas



NCCIC

NATIONAL CYE JRITY AND

INTEGRATION CENTER

National Cyber Awareness System:

Google Releases Google Chrome Update
01/28/2014 11:57 AM EST

Original release date: January 28, 2014

Google has released Google Chrome 32.0.1700.10:
Frame to address multiple vulnerabilities. These vu
cause a denial of service or bypass intended securit

US-CERT encourages users and administrators to r«
and follow best—practice security policies to deterrr

This product is provided subject to this Notification

US-CER ™

UNITED STATES COMPUTER EMERGENCY READINESS TEAM

Getting Security Updates

==

& NCCIC

National Cyber Awareness System:

UNITED STATES COMPUTER EMERGENCY READINESS TEAM

TA14-017A: UDP-based Amplification Attacks
01/17/2014 03:22 PM EST

Original release date: January 17, 2014 | Last revised: February 09, 2014
Systems Affected

Certain UDP protocols have been identified as potential attack vectors:

e DNS

e NTP

e SNMPv2
e NetBIOS
e SSDP

e CharGEN
e QOTD

e BitTorrent

e Kad

e Quake Network Protocol
e Steam Protocol

Overview

A Distributed Reflective Denial of Service (DRDoS) attack is an emerging form of Distributed
Denial of Service (DDoS) that relies on the use of publicly accessible UDP servers, as well as

———
US-CERT



Protecting Host from Net
Host Based Firewall



Protecting Host from Net
Host Based Firewall
Windows



Host Based Firewall: Windows

vv'ﬁ » Control Panel » System and Security » Windows Firewall

@Uv ﬁ » Control Panel » System and Security » Windows Firewall

Control Panel Home

Allow a program or feature

through Windows Firewall
) Change notification settings

) Turn Windows Firewall on or
off

®) Restore defaults
#) Advanced settings

Troubleshoot my network

Action Center

Network and Sharing Center

Help protect your computer with Windows Firewall

‘Windows Firewall can help prevent hackers or malicious software from gaining access to your computer
through the Internet or a network.

How does a firewall help protect my computer?

What are network locations?

. ‘a‘ Home or work (private) networks Not Connected (¥)

. ‘0‘ Public networks Connected (&)

Networks in public places such as airports or coffee shops

Windows Firewall state: On

Incoming connections: Block all connections to programs that are not on the
list of allowed programs

Active public networks: B Network

Notification state: Notify me when Windows Firewall blocks a new
program




Host Based

ndows Firewall with Advanced Security

Action

View Help

indows Firewall with Advancy

| Inbound Rules
| Outbound Rules

| Connection Security Rules
| Monitoring

[ »

Inbound Rules

Name
@ Bonjour Service

@ Bonjour Service

@iTunes

@ McAfee Shared Service Host

@ McAfee Shared Service Host

@ webkit

@ BranchCache Content Retrieval (HTTP-In)

@ BranchCache Peer Discovery (WSD-In)

@ Connect to a Network Projector (TCP-In)
@ Connect to a Network Projector (TCP-In)

@ Connect to a Network Projector (WSD-In)

@ Core Networking - Internet Group Mana...
@ Core Networking - IPHTTPS (TCP-In)
@ Core Networking - IPv6 (IPv6-In)

@ Core Networking - Multicast Listener Q

@ Core Networking - Neighbor Discovery A.

@ Core Networking - Parameter Problem

@ BranchCache Hosted Cache Server (HTT...

@ Connect to a Network Projector (WSD Ev...
@ Connect to a Network Projector (WSD Ev...
@ Connect to a Network Projector (WSD Ev...
@ Connect to a Network Projector (WSD Ev...

@ Core Networking - Destination Unreacha...
@ Core Networking - Destination Unreacha...
@ Core Networking - Dynamic Host Config...
@ Core Networking - Dynamic Host Config...

@ Core Networking - Multicast Listener Do...

@ Core Networking - Multicast Listener Rep...
@ Core Networking - Multicast Listener Rep...

@ Core Networking - Neighbor Discovery S...
@ Core Networking - Packet Too Big (ICMP...

BranchCache - Content Retr.

BranchCache - Hosted Cach...
BranchCache - Peer Discove...

Connect to a Network Proje,

Connect to a Network Proje...
Connect to a Network Proje...

Connect to a Network Proje,

Connect to a Network Proje...
Connect to a Network Proje...
Connect to a Network Proje...

Core Networking
Core Networking
Core Networking
Core Networking
Core Networking
Core Networking
Core Networking
Core Networking
Core Networking
Core Networking
Core Networking
Core Networking
Core Networking
Core Networking
Core Networking

@Ccre Networking - Router Ad» i er

. Core q

Profile
Public
Public
All
Public
Public
All

All

All

All
Domain
Private...
Domain
Private...
Private...
Domain
All

All

All

All

All

All

All

All

All

All

All

All

All

All

All

All

All

Enabled

Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow
Allow

Override

No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No
No

<

Program
C:\Progr...
CAProgr...
CAProgr...
C:\Progr...
C:\Progr...
CAProgr...
SYSTEM
SYSTEM
%system...
%System...
%System...
System
System
System
System
%System...
System
System
%System...
2%System...
System
System
System
System
System
System
System
System
System
System
System
System

Firewall: Windows

Local Address
Any
Any
Any
Any
Any
Any
Any
Any
Any
Any
Any
Any
Any
Any

Local subnet
Any
Local subnet
Any
Local subnet
Local subnet
Any
Local subnet

Local subnet
Local subnet
Local subnet
Local subnet

Remote Alidress

[~}

v
A4
h'd

BB

Actions
|| Inbound Rules

Filte

View

Refresh

New Rule...

Filter by Prof

Filter by Group

ate

Export List...

Help



Host Based Firewall: Windows

e The Windows firewall offers four types of
rules:
— Program - Block or allow a program.

— Port - Block or a allow a port, port range, or
protocol.

— Predefined - Use a predefined firewall rule included
with Windows.

— Custom - Specify a combination of program, port, and
IP address to block or allow.



Host B

¢ 6 6 ¢ ¢ ¢ 6

Rule Type
Program

Protocol and Ports
Scope

Action

Profile

Name

To which ports and protocols does this rule apply?

Protocol type: I TCP
Protocol number: 6
Local port: [Spec‘rfic Ports S ]
80. 443
Example: 80, 443, 5000-5010
Remote port: [AJI Ports 'J

Example: 80. 443, 5000-5010

Intemet Control Message Protocol
(ICMP) settings:

ased Firewall: Windows

@ New Inbound Rule Wizard

Scope

Specify the local and remote |P addresses to which this rule applies

Steps:

@ Rule Type

@ Program Which local IP addresses does this rule apply to?
@ Protocol and Ports @ Any IP address

@ Scope These IP addresses:

. .

@ Profile

@ Name

Customize the interface types to which this rule applies:

‘Which remote IP addresses does this rule apply to?
Any |IP address

@ These IP addresses

1111

Leam more about specifying scope

Customize...




Protecting Host from Net
Host Based Firewall
Linux



Host Based Firewall: IPTABLES

IPTABLES Structure

IPTABLES
>TABLES
>CHAINS
>RULES




Host Based Firewall: IPTABLES

IPTABLES table & chains




Host Based Firewall: IPTABLES

IPTABLES Rules

— Rules contain a criteria and a target.

— If the criteria 1is matched, it goes to the rules
specified in the target (or) executes the special
values mentioned in the target.

— If the criteria is not matched, it moves on to the
next rule.



Host Based Firewall: IPTABLES

Displaying the Status of Your Firewall

root@access /h/fakrul# iptables -L -n

Chain INPUT (policy ACCEPT 1885K
num pkts bytes

0

= Wi -

0
0
0

Chain FORWARD (policy ACCEPT 0 packets,
num pkts bytes

1 0
2 0
3 0
4 0
5 0

Chain OUTPUT (policy ACCEPT

O OO oo

target
ACCEPT
ACCEPT
ACCEPT
ACCEPT

target
ACCEPT
ACCEPT
ACCEPT
REJECT
REJECT

num pkts bytes target

prot

udp
tcp
udp
tcp

prot

all
all
all
all
all

packets, 417M bytes)
source
.0.0/0

opt in

-- virbro0
-- virbro0
-- virbro0
-— virbro0

opt in
[ *

-— virbr0 *
-- virbr0 virbr0

JE— *

-— virbr0 *

1843K packets,
prot opt in

* F * X

.0
.0.0/0
0

0 bytes)

147M bytes)
source

.0/0

.0/0

source

0.0/0
168.122.0/24
0.0/0
0.0/0
0.0/0

destination
168.122.0/24

d
0
0
0
0

tination

0

0
0
0

192.

0.0.0
0.0.0
0.0.0
0 0

destination

—=line-numbers

udp dpt:53
tcp dpt:53
udp dpt:67
tcp dpt:67

state RELATED,ESTABLISHED

reject-with icmp-port-unreachable
reject-with icmp-port-unreachable



Host Based Firewall: IPTABLES

Displaying the Status of NAT Table

root@access /h/fakrul# iptables -t nat -L -n -v

Chain PREROUTING (policy ACCEPT 867 packets, 146K bytes)

pkts bytes target prot opt in out source destination
0 0 DROP all -- wvlan2 = 0.0.0.0/0 192.168.1.0/24

Chain POSTROUTING (policy ACCEPT 99 packets, 6875 bytes)
pkts bytes target prot opt in out source destination
0 0 MASQUERADE all -- * vlan2 0.0.0.0/0 0.0.0.0/0

Chain OUTPUT (policy ACCEPT 99 packets, 6875 bytes)
pkts bytes target prot opt in out source destination



Host Based Firewall: IPTABLES

Stop / Start / Restart Firewall
— CentOS / RHEL / Fedora Linux:
# service iptables stop
# service iptables start
# service iptables restart

— Delete Firewall Rules
# iptables -L INPUT -n --line-numbers
# iptables -L OUTPUT -n --line-numbers
# iptables -L OUTPUT -n --line-numbers | less

# iptables -L OUTPUT -n --line-numbers | grep
192.168.1.1



Host Based Firewall: IPTABLES

Save Firewall Rules
— CentOS / RHEL / Fedora Linux:
# service iptables save
— For other distro:
# iptables-save > /root/iptables rules
— Restore Firewall Rules:
# iptables-restore < /root/iptables rules



Host Based Firewall: IPTABLES

Sample Rules
# iptables -A INPUT -i ethl -s 192.168.0.0/24 -3j DROP
# iptables -A INPUT -i ethl -s 10.0.0.0/8 -j DROP

# iptables -A INPUT -i ethl -p tcp --dport 80 -j ACCEPT
# iptables -A OUTPUT -d 75.126.153.206 -j DROP

# iptables -A INPUT -i ethl -s 10.0.0.0/8 -j LOG --log-
prefix "IP SPOOF A: »

# iptables -A INPUT -i ethl -s 10.0.0.0/8 -j DROP



Host Based Firewall: IPTABLES

Block or Allow ICMP Ping Request

# iptables -A INPUT -p icmp --icmp-type echo-request -7
DROP

# iptables -A INPUT -i ethl -p icmp --icmp-type echo-
request -3j DROP



Host Based Firewall: IPTABLES

# iptables -L
— Chain INPUT (policy ACCEPT)
— Chain FORWARD (policy ACCEPT)
— Chain OUTPUT (policy ACCEPT)

SIS

iptables -P INPUT DROP
iptables -P OUTPUT DROP
iptables -P FORWARD DROP

H* H*



Host Based Firewall: IPTABLES (Bogon
Filter)

# iptables -A INPUT -i ethO -s 10.0.0.0/8 -j LOG --log-prefix "IP DROP SPOOF "

# iptables -A INPUT -i eth0O -s 172.16.0.0/12 -j LOG --log-prefix "IP DROP SPOOF "
# iptables -A INPUT -i eth0O -s 192.168.0.0/16 -j LOG --log-prefix "IP DROP SPOOF
# iptables -A INPUT -i ethO -s 224.0.0.0/4 -j LOG --log-prefix "IP DROP MULTICAST
# iptables -A INPUT -i ethO -s 240.0.0.0/5 -j LOG --log-prefix "IP DROP SPOOF "

# iptables -A INPUT -i eth0 -d 127.0.0.0/8 -j LOG --log-prefix "IP DROP LOOPBACK
# iptables -A INPUT -i ethO -s 169.254.0.0/16 -j LOG --log-prefix "IP DROP
MULTICAST "

# iptables -A INPUT -m tcp -p tcp --dport 80 -j ACCEPT

# iptables -A INPUT -s 103.12.179.0/24 -m state --state NEW -p tcp --dport 22 -j
ACCEPT

# iptables -D INPUT -s 103.12.176.0/22 -m state --state NEW -p udp --dport 123 -j
ACCEPT



Protecting Host from Net
Backups



Backups General

« Know what you are going to backup.

e For servers, this needs to be centralized
where as for end user devices this will
usually need to be individual systems.

* Test recovery procedure.
e Incremental VS full backups.

* For personal backups, consider what happens
when you travel.



Backups General

 Automate the backups as much as possible to
avolid people forgetting.
* Consider encrypted contents: your backups must

have at minimum the same encryption level as
the source data.

* For personal backups, the backup disks will
need to be kept separate from the machine - or
you may lose both.



Backups: Windows

e Inbuilt windows backup.

* Needs to be setup - does not seem to exist on starter
or home editions.
— Control Panel->System and Security ->Backup and Restore

e Recovery is non trivial.

* NTFS has the ability to create snapshots on an external
drive.

« Other option is things like dropbox/Google Drivel!!

e Software on some external drives comes with “one touch”
backups.

— Some with hardware encryption on the external drive.



Backups: Linux

* Host based backups are more or less same
software options as server based network

backups.

e Some distributions automate backups to
external drives
— https://wiki.ubuntu.com/HomeUserBackup

* You can also use home made scripts to use SSH
to copy critical data to a remote server



Backups: 0S X

« System events make it easy to automatically
launch backups as soon as a particular disk is
plugged 1in.

e Options for remote backup are the same as for
Linux/Unix

* From 10.5 all systems come with “time machine”
— Mixes full and incremental backups.



Backups: 0S X

— Dead easy to setup and comes with the 0S.
— Issues with encrypted home directories et al.
e Carbon Copy Cloner

— Can create a bootable copy.
— Can also do both incremental and full backups



Protecting Host from Net
Authentication



Authentication

e Recall for some services we mentioned two
factor authentication.

e Each host in addition needs methods to
authenticate the users going to use the host.

* Some enterprise “
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centralized authentication.




Authentication

e If using directory services, consider what
happens when someone is off-campus.

— Request denied?
— Fall back authentication to local machine?

* For hosts that are servers or routers having
centralized authentication means you do not
have to maintain credentials on each devices.
— Radius or TACACS is common for networking kit
— LDAP, Active Directory, Kerberos also possible.



Authentication

* Biometrics for personal computing is possible
but not always that accurate and is a headache
to manage. Good as one of the two factors
though.

* For a particular enterprise, pick an
authentication scheme that is consistent for
whatever hosts are acceptable in that
environment.



